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Note: To avoid damage of your speakers, always turn down the volume or 
turn off the power of your amplifier connected to the ST Audio MEDIA 
7.1 when you are rebooting or shutting down your PC. 
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FCC NOTICE 
 
 
 

THIS DEVICE COMPLIES WITH PART 15 OF THE FCC FULES. 
OPERATION IS SUBJECT TO THE FOLLOWING TWO CONDITION: 
(1) THIS DEVICE MAY NOT CAUSE HARMFUL INTERFERENCE, AND 
(2)  THIS DEVICE MUST ACCEPT ANY INTERFERENCE RECEIVED,  
(3) INCLUDING INTERFERENCE THAT MAY CAUSE UNDERSIRED OPERATION. 

 

 

This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to part 15 of the FCC Rules. These limits 
are designed to provide reasonable protection against harmful interference 
in a residential installation. This equipment generates, uses and can radiate 
radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communication. 
However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause harmful interference to  
radio or television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures :  
 
- Reorient or relocate the receiving antenna.  
 
- Increase the separation between the equipment and receiver.  
 
- Connect the equipment into an outlet on a circuit difference from that to 

which   the receiver is connected.  
 
- Consult the dealer of an experienced radio/TV technician for help.  
 

 

NOTE : The manufacturer is not responsible for any radio or TV 
interference caused by unauthorized modifications to this equipment.  
Such modifications could void the user’s authority to operate the  
equipment.  
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I. Introduction 

Congratulations on your purchase of the MEDIA7.1 by ST Audio. The MEDIA 7.1 
is a PCI interface card and External Box to connect phono input compatible 
hardware such as multichannel recorders, digital mixers, synthesizers, etc. with 
your PC. With much experience in the audio and PC industry over a long period of 
time and along with valuable suggestions from our customers, our engineers have 
developed a product we know you will be satisfied with. We guarantee you 
uncompromising quality as well as excellent technical and audio properties at an 
extremely affordable price. 

What’s in the box? 

You should have received the following with your MEDIA 7.1 card: 

• ST Audio MEDIA 7.1 PCI audiocard 
• ST Audio MEDIA 7.1 external box 
• D_SUB cable (15pin D-SUB for linking from audiocard to external box) 
• 4pin-3pin cable for analog CD-ROM audio connection 
• driver and installation CD 
• Bundle CD 
• this manual 

Functions 

The MEDIA 7.1 card from ST Audio installs easily and contains everything you 
need to form a powerful 8 channel output and support powerful hard recording of  
phono input and also phantom power  recording to your Windows PC. Just insert 
the ST Audio MEDIA 7.1 card into an available PCI slot and connect it with 
external. The available analog output allows 8channel with your DVD device 
without a separate external reciever unit. 

Digital editing with the MEDIA 7.1 card from ST Audio makes many jobs in the 
studio effortless. For example, using the turn-table you can send audio at up to 
24-bit resolution into your computer, graphically edit your tracks in your favorite 
software application and send them back to tape for mixdown, archiving etc. 
Another great application is using your digital mixer as the AD/DA audio interface 
for all famous computer recording software applications.  
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II. Specifications 

• PCI 2.1 compliant interface 
• 2 simultaneous analog input channels (24bit/96Khz) 
• 8 simultaneous analog output channels (24bit/96Khz) 
• AKM4529 ADC/DAC 100dB S/N ratio (a-weighted) 
• Optical and Coaxial  S/PDIF I/O (24bit /96Khz) 
• supported sample rates: 22.05, 32, 44.1 and 48kHz (plus 88.2 and 96kHz for 

S/PDIF) 
• On-board hardware synthesizer (DREAM /Roland GS soundset) 
• internal CD in plus Aux In via AC-97 Codec (Internal Mixer) 

• MPU-401 compatible MIDI In/Out interface 
• drivers for Windows 9x/Me, NT4 and Windows 2000 available 
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III. In- and output connectors 

PCI card connectors / options 

 

1.     Microphone input to internal device 
2.     Line input to internal device 
3.     MO- mix out (connect to MI connector of External Box with stereo cable) 
4.     D-SUB connects to external box  
5.     Analog CD input (routed to Internal Mixer) – CON1 
6.     Analog Aux input (routed to Internal Mixer) – CON2 
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External Box 

Font Panel 

 

1. Head phone connector (adjustor and 1/4 inch input connector) 
2. Gain controller and peak LED 
3. Phantom power (on – phontom on, off – phantom off) 
4. 1/4 inch line input connector  
5. RCA input connector and Phono input selector (off- phono, on- line input) 
6. S/PDIF input connector 
7. S/PDIF output connector 
8. Power LED 
 
Rear Panel 

 
1. MPU401 MIDI In/Out port  
2. D-SUB connector (link D_SUB cable to audio card)  
3. RCA analogue output connector 
4. Stereo output connector for DVD user 
5. MI (mix in) connector – link to MO connector of audio card with stereo cable 
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IV. Hardware installation 

Make sure the computer is switched off and unplugged. Remove the external 
computer cover. Insert the ST Audio MEDIA 7.1 PCI-card into a free PCI slot 
making sure that it is pressed firmly into position and secure it to the computer 
case. 

You can use an analog cable to from the CD-ROM drive if you want to listen to 
audio CDs via the analog monitoring output of the card.  

Now install the computer cover again and connect the included D_SUB cable from 
audio card D_SUB connector to external box of  the D-SUB connector. 

. 
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V. Driver and software installation 

Driver installation 

The MEDIA 7.1 comes with a CD-ROM that contains drivers for Windows 9x/Me 
and 2000. The following instructions refer to Windows 98 only. The installation 
under Windows 95, Windows Me, Windows 2000 and Windows XP is very similar, 
although the displayed dialog boxes might look different. 

After installation of the MEDIA 7.1 in a PCI slot in the computer, boot up the 
system. Windows will detect the new hardware automatically  and display the 
following screen. 

 

Click Next. 
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Select Search for the best driver for your device and click Next. 

 

 D:\sound\dspadat\driver  

 

Check Specify a location. Do not check CD-ROM drive or Floppy disk drives. Type 
in <drivename>:\media\driver in the window displayed above and click Next. 
Alternativly, you can click Browse and select the correct directory on the CD, then 
click Next. 
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After Windows finds the driver you should see the above screen naming the driver 
file indicated in the screenshot. Click Next. 

 

At this window complete the installation by clicking Finish . Windows will now 
install the driver for you through a series of installation screens. If you are 
prompted to do anything (this would be unusual), please follow the directions on 
screen. 

After the driver is installed ensure the installation worked by pressing Start > 
Settings > Control Panel > System > Device Manager > Sound , video and game 
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controllers. You should see the audiocard's device listed there. Highlight it and 
click on Properties. You should see the message This device is working properly 
(this text is not neccesarily displayed under Windows 2000). Click on the 
Resources tab, you should see the message No conflicts. If so, congratulations are 
in order. You have successfully installed the drivers for the ST Audio DSP24  
MEDIA 7.1. 

 

Software installation 

After successfully installing the driver above, Media7.1 output mixer program 
which control your Media 7.1 card and box  is automatically install to your system.  

You can find this application program (ST Audio control panel) on “Control Panel”  
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VI. Media 7.1 Output Mixer 

Media 7.1 output mixer  is the control center of the MEDIA 7.1 card. It controls the 
monitoring of your PC based studio. Different studio envrionments (e.g. analog 
mixing desk vs. PC as digital mixer) require different monitoring setups. 
Sometimes you want to listen to the signal you are recording at the moment. 
Sometimes you want to listen to a modified version of the signal (e.g. processed by 
an effect processor) or you do want to listen to a completly different audio track 
while recording. This means that you need to be able to define what exactly is 
played through the separate output channels of your audiocard and Media 7.1 
Output Mixer  allows you to do that. 

What is displayed by  Media 7.1 Output Mixer? 

 

The software is divided into two main sections. The output channels of the card are 
displayed on the left side of the window. The first output channel pair (Output 1,2) 
is  used as analog monitoring output  with link to Mixer. The right sect ion 
symbolizes the I/O interface on the MEDIA 7.1 card. The connectors on the left 
side (white circles) are the available sources for the outputs.  

The virtual cables for the outputs (which mainly control the monitoring) cannot be 
removed but replaced by other connections. These connections are displayed as 
straight lines between the white circles. The available input soures are: 
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• Mixer : Whole available output  
• S/PDIF Input; the signal from the coaxial 

S/PDIF input of the card 

• Wave S/PDIF Out; the playback of the wave 
device ADSP24 S/PDIF Out (n)  or channel 
9/10 of the ASIO/GSIF driver 

• Input 1,2; the signal from channel 1/2 of the 
optical ADAT input  

• MIDI Synthesizer : Hardware MIDI output 
from DREAM chipset. (ADSP24 MIDI 2 
device)  

• WaveOut 1,2; the playback of the wave device ADSP24 Ext. WaveOut 1/2 (n) 
or channel 1/2 of the ASIO/GSIF driver 

• WaveOut 3,4; the playback of the wave device ADSP24 Ext. WaveOut 3/4 (n) 
or channel 3/4 of the ASIO/GSIF driver 

• WaveOut 5,6; the playback of the wave device ADSP24 Ext. WaveOut 5/6 (n) 
or channel 5/6 of the ASIO/GSIF driver 

• WaveOut 7,8; the playback of the wave device ADSP24 Ext. WaveOut 7/8 (n) 
or channel 7/8 of the ASIO/GSIF driver 

All of these available signal sources can be connected to the outputs on the left side 
of the Media7.1 Output Mixer window. 

Output part 

For each stereo channel pair it is possible to 
activate direct monitoring (without any latency). 
As in the picture, you simply do it by connecting 
Input 1,2  to Output 1,2 . This means that the signal 
from the input channel 1/2 is sent directly to the 
output channel 1/2 without any latency / delay. 
The signal you play inside your application via 
channel 1/2 is not audible now of course! 

If you connect WaveOut 1,2 with Output 1,2, the 
playback from your audio application is audible 
via the first output channel pair of the ADSP24 
Ext. 1/2 audio device output. The signal from the input is not audible at the same 
time! 
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And if you enjoy DVD with your DVD-ROM than you must setting like this. So 
you can hear each channel of outputs properly.  

 

 Mixer 

The limitation of these two options for monitoring (which is a limitation of many 
pro audiocards) is that you cannot hear the input and output signal at the same time. 
If you use an analog (or digital) mixer that is connected to both the inputs and the 
outputs of the MEDIA 7.1 card, you can monitor via the mixer so that is no problem. 
The DSP24 hardware however has a built -in digital mixer so you do not really need 
an external mixing desk. This function is called  Mixer (easy  to remember!) and as 
the input and playback signals, you can connect it to Output 1,2 as shown on the 
picture. 

If the  Mixer is connected to Output 1,2 (or alternativly to S/PDIF Out), all input 
and all playback signals are audible simultaneously via the first two channels of the 
analog monitoring output (or alternativly via the coaxial S/PDIF output). When you 
open the Media7.1 Output Mixer, you can set the volume for each playback and 
input channel independandly. This allows you to create your own mix completly 
digitally inside your PC without the need of  external mixing equipment and 
without the need for special software from third parties. This final mix can even be 
digitally resampled using the ADSP24 (n) Digital Mixer MME wave device or 
channel 11/12 of the ASIO 2.0 driver. Check the section OUTPUT MIXERin the 
following chapter of this manual for reference. 
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Clock source selection 

The clock status display  in the upper left corner of Media7.1 Output Mixer allow to 
show present clock status for the MEDIA 7.1 card: 

 Internal Select this (default) if the MEDIA 7.1 should be the master clock 
source for all operations. All digital devices connected to the 
S/PDIF output of the card need to work with external 
synchronisation in this case. 

 External Select this clock source when you want to record from the S/PDIF 
input with the clock supplied by the device connected to the coaxial 
digital input of the card. Please note that you cannot select S/PDIF 
as clock source and record from the external digial device like DAT 
digital input at the same time. 

Please note that it is very important that an active device is connected to the digital 
input ( S/PDIF) when the sync is set to external ( S/PDIF). It is not possible to 
record a clean signal from the digital input if you use internal synchronisation ... 
also it is not possible to playback and record clean signals (on any in - and output) if 
you use external synchronisation without anything connected to the digital input. In 
fact, on some systems it is not possible to record and playback at all with a wrong 
sync setting! It is important to use this setting very carefully. It can also be changed 
in the Hardware Settings dialog (accesable via the File menu). 
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VII. Mixer controls 

Internal Mixer 

Clicking on Call Internal Mixer inside Media7.1 Output Mixer will launch the 
Internal Mixer: (This mixer is Windows basic Mixer) 

The Internal Mixer on the MEDIA 7.1 represents basically an additional soundcard 
which has been 'added' to the audiocard functions. You can use the this section to 
play Windows sounds or the metronome from a sequenzer, also you could use it for 
consumer applications such as games or for internet phone usage. Since the 
Internal Mixer even supports DirectSound, you can use it also for some 
conventional software synthesizer applications. The Internal Mixer is exactly same 
of the Windows mixer (SNDVOL32.EXE - for Windows NT4/2000/XP) is used to 
control these functions. The Internal Mixer is represented by an AC-97 codec chip 
that is on your MEDIA 7.1 card. AC-97 has been defined as standard by Intel for 
consumer audio applications on modern PCs. The AC-97 codec ST Audio is using 
works with a 18bit ADC, a 18bit DAC and an analog mixer. The output of the 
Internal Mixer is audible via the analog monitoring output only. 

Note that you would never use the Internal Mixer for high quality recording or 
playback for music production. This means: if you have no need for consumer 
audio applications (as mentioned above) or if you are using a separate consumer 
soundcard in your PC for such applications, you would never use the Internal 
Mixer and you can stop reading this chapter now. The Internal Mixer is a nice 
addition to the main function set of the MEDIA 7.1 card - not more, not less. 
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 Output Mixer 

With the Output Mixer you can control all incoming and outgoing signals. Open it 
by clicking on Call Output Mixer. 

 

Note: The Output Mixer will only change the audible signal for monitoring 
purpouses. When you are recording an input signal, the Output Mixer does not 
change the signal level. This ensures that you are always recording with best 
possible audio quality without reduction of the dynamic range. 
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Master 

Controls the output volume of the Output Mixer . The signal controlled here 
will be played through channel 1/2 ofoutput and/or through the S/PDIF output. 
It is even possible to resample the output signal of the Output Mixer internally 
using the device ADSP24 Digital Mixer (n) or channel 11/12 of the ASIO 
driver. 

You can control the the volume of the left and right channels independandly. 
Muting the signal is possible as well. 

 

Wave (1/2 to 7/8) 

In the Wave section you can control the volume of the playback signal (for the 
devices ADSP24 Ext.(n) WaveOut x/x or the channels 1~8 of the ASIO and 
GSIF driver). 

Muting each channel is possible. Also you can control the panning 
independand for the left and right channel of each stereo device. 

 
 
 

 

S/PDIF In / Out 

In the S/PDIF In Out section you can control the volume of the 
signal of the device ADSP24 Ext. S/PDIF In Out (n) or channel 9/10 
of the ASIO and GSIF driver. 

Muting the left and right channels is possible independandly. 
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Input (1/2) 

This section is controlling the volume of the different input channels from the 
analogue input of external box unit . 

Muting the left and right channels is possible independandly. 

 

 

 

 

 

MIDI Sync 

This section is controlling the volume of the DREAM MIDI chipset. 

If you want to use internal hardware MIDI device than you must choose 
ADSP MIDI2 device on “Sound and Audio device” of Control Panel. 

 

Notice : ADSP  MIDI 1 device is for external MIDI device from external 
box unit. 
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VIII. Hardware settings 

The Hardware Settings dialog of the MEDIA 7.1 is used to control the basic driver 
settings of the audiocard. The same dialog is used also for all other DSP24 series 
cards from ST Audio. You call it via Media7.1 Output Mixer. The Hardware 
Settings dialog is also used when you open the ASIO control panel from an ASIO 
compatible sequencer such as Emagic Logic Audio or Steinberg Cubase VST. 

The upper section allows you to select 
the card (if you have multiple DSP24 
cards installed in your PC) and 
displays the current version of the 
driver that is installed. Also you can 
see the current latency that has been 
selected for the ASIO 2.0 driver. 
Below t hat, you can see the resolution 
of the converters that are used in your 
hardware installation. This will be 
always 24-bit as the DAC used for 
monitoring on the card works with 
24-bit resolution.  

Clock Setting 

The Clock Setting tab controls the 
samplerate and bit -deepth (resolution) 
the card operates.  

Under Audio Data Handling you can 
determine if the card allows you to playback and record with a bit-deepth that us 
higher as the converter resolution (displayed above). As the converter resolution on 
the MEDIA 7.1 is 24-bit, it does not matter in most situation what is selected here. 
The default setting is Allow operation when data exceeds converter resolution. 

The Clock and Sample Rates (Hertz)  section allows you to select the source of the 
clock for the DSP24 card. You can select between Internal Master Clock and 
External Master Clock. Make sure to select External Master Clock only if you will 
be recording or monitoring from the ADAT or S/PDIF input of the card. In that 
case, the device that is connected to the input will supply the clock for all 
operations you perform with the card. If you select Internal Master Clock (default), 
the clock generator on the card will generate the samplerate. You will have 
problems with noise and clicks in your audio signal if you have selected external 
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clock without an active device (DAT, MD, digital mixer, etc.) on the digital input. 
Also you will have similar problems when you want to record a signal from the 
digital input with the card set to internal clock. 

The section of the Hardware Settings dialog also shows the current sample rate of 
the card, which has been set by your application software. The samplerate selected 
here will be used for all functions of the card. This includes the digital output, so if 
you sync an external device (MD, DAT, digital mixer, etc.) to the DSP24 card, it 
will use the clock that is selected here. The Rate Locked option is used to force the 
card to a specific samplerate. It is disabled by default (which is also our 
recomendation) which automatically allows your application software access to all 
supported samplerates. When the option is enabled, your software will only work 
with the selected sample rate. This means that any application that attempts to use 
the driver at a different sample rate will show an error message. Reset Rate After 
Play should be selected when you want that the sample rate return to a specific 
setting when no software is using the card for playback or recording. This is 
especially important if your external device that is connected to the digital output of 
the card is synched to the DSP24 card. If you just use the analog outputs, the 
selected samplerate and the Reset Rate After Play option are not important when 
the card is not used by your software at the moment. 

Keep in mind that the ADAT protocol does not support higher sample rates as 
48kHz. This means that you can only select 88.2 and 96kHz when you are working 
with S/PDIF signals.  

Device Setting 

The Device Setting  tab controls the 
options needed for playback and 
recording.  

Under Waveout Driver you can select 
the MME/ASIO buffer size (latency). 
The smaller the selected value is, the 
smaller the resulting latency of the 
ASIO driver will be (and the other 
way round). You might notice the 
latency when you perform some 
action inside your ASIO application 
(e.g. you are using a VST instrument 
in Cubase VST): the result of your 
action will be audible with a certain 
delay - the latency. With the current 
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drivers (v6.x for Windows 9x/Me), the latency can be lowered to 5.5ms at 44.1kHz 
when the smallest value (256) is selected. The Windows 2000 drivers allow you to 
lower the latency to 7.5ms at 44.1kHz. If you increase the samplerate, the latency 
will be automatically lower (e.g. 88.2kHz will give you exactly halve of the latency 
time as 44.1kHz with the same buffer size; keep in mind that ADAT supports 
48kHz max.). 

You have to keep in mind that a smaller latency also increases the PC utilization 
and might have some influence on the performance (very much depending on the 
PC configuration). A buffer size that is too small may result in clicks or drop outs in 
the audio signal. Larger buffers could prevent this. This buffer size should be set in 
the this dialog before you launch your music software. In some ASIO applications 
it is important to re-launch the software even if you have changed the buffer size 
via the ASIO control panel inside the application. We strongly recommend this for 
Logic SoundTrack24 and other versions of Logic Audio from Emagic for example 
but it is also better for all other ASIO applications.  

The WaveDriver setting under the MME/ASIO buffer allows you to change the 
latency of the MME driver in ms for Windows 2000. 

The MME drivers of the DSP24 card automatically synchronize the beginning of 
recording and playback for all audio devices. For some software applications that 
are using several MME devices simultaneously, you should select Single and 
In-Sync under MultiTrack Wave Drivers to ensure that all channels will begin 
playback and/or recording at exactly the same time. Otherwise select Independent - 
this allows you to use the cards MME devices with more than one application at the 
same time. 

Multiclient Support (Device Mixing) 

The DeviceMixing (MME / ASIO 
/ GSIF) section allows you to 
assign individual stereo output 
pairs to a certain driver model to 
be able to use several different 
programs (e.g. GigaSampler- / 
Studio and a Audio- / MIDI- 
Sequencer like Logic Audio or 
Cubase VST) at the same time. 
These functions are not available 
under Windows NT 4.0, 2000 and XP (as GigaSampler-/Studio did not support 
these operting systems when this manual was created). 
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Multiclient support is available for MME drivers (e.g. usually used by WaveLab, 
Sound Forge, Cool Edit, Cakewalk, ...), the ASIO driver (e.g. used by Logic, 
Cubase VST, Reaktor, ...) and the GSIF driver (used by GigaSampler and 
GigaStudio). This even allows you to use GSIF software that was designed to run 
separatly on a system without other software parallel to other audio programs.  

The example on the picture (previous page) shows a setup where the output 
channels 1~4 and the S/PDIF output channels are assigned to the ASIO driver. 
Channels 5~8 are assigned to GSIF. This setup is done before  you start 
GigaSampler/-Studio and your ASIO application. It is not possible to change 
DeviceMixing setttings after you have launched your audio application(s). 

The last column of the section displays the resulting channel numbers. In this 
example, the S/PDIF output channel (which is usually 9,10) has been assigned to 
channel 5,6 of the ASIO driver. Also, the channels 5~8 are assigned to channels 
1~4 of the GSIF driver. This assignment is needed, because the DSP24 driver 
simulates a normal audiocard interface in the different driver models for the 
applications. This prevents compatibility issues with certain audio applications. 

It is not recommended to change this setup often, as the different applications will 
also save the channel assignments internally. If you change the settings in the 
DeviceMixing  section, it is wise to double-check the soundcard setup inside the 
audio apps you are using after that. These options have been invented because of 
the demand from the users to be able to use GigaSampler/Studio simultanously to 
famous Audio-/MIDI-Sequencer software. We strongly recommend to use at least 
v1.64 of GigaSampler or v2.2 of GigaStudio in order to use the multiclient support. 
The performance may not be as good when using earlier versions of the software. 
GigaStudio 2.2 and above will give you best performance. 
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IX. Usage with software applications 

For each application you are using with the MEDIA 7.1 you have to follow some 
configuration steps. Basically, every stereo input or output channel of the card can 
be used like a normal soundcard using the corresponding devices. Normally every 
program will have a configuration function where you can select the devices. 

Available in- and output devices 

The available wave devices for playback and recording are ("n" will be substituted 
with the number of the installed DSP24 card, normally 1): 

• ADSP24 Int. WaveOut (n) – plays audio data through the Internal Mixer 
(which will be audible only on the analog output of the card). Please note that 
this driver only supports 16bit/48kHz as maximum resolution and samplerate. 

• ADSP24 Ext.(n) WaveOut 1/2 – first stereo wave output device. Use this 
driver to play audio through channels 1/2 of the ADAT output. 

• ADSP24 Ext.(n) WaveOut 3/4 – second stereo wave output device. Use this 
driver to play audio through channels 3/4 of the ADAT output. 

• ADSP24 Ext.(n) WaveOut 5/6  – third stereo wave output device. Use this 
driver to play audio through channels 5/6 of the ADAT output. 

• ADSP24 Ext.(n) WaveOut 7/8  – fourth stereo wave output device. Use this 
driver to play audio through channels 7/8 of the ADAT output. 

• ADSP24 Ext. S/PDIF Out (n) – plays audio through the stereo S/PDIF digital 
output. 

• ADSP24 Multiple PCM Out (n) – this is an interleaved driver for playback of 
several channels at the same time. Some older audio applications are using 
this driver to access multiple channels on soundcards.  

• ADSP24 Int. Record (n) – records the signal from Internal Mixer. Use this 
driver to record from the internal CD or Aux input on the card. Please note 
that this driver only supports 16bit/48kHz as maximum resolution and 
samplerate. 

• ADSP24 Ext.(n) Input 1/2  – first stereo input driver to record input signals 
from your ADAT device (channels 1/2). 
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• ADSP24 Ext.(n) Input 3/4 – second stereo input driver to record input signals 
from your ADAT device (channels 3/4). 

• ADSP24 Ext.(n) Input 5/6  – third stereo input driver to record input signals 
from your ADAT device (channels 5/6). 

• ADSP24 Ext.(n) Input 7/8  – fourth stereo input driver to record input signals 
from your ADAT device (channels 7/8). 

• ADSP24 S/PDIF In (n) – records signal from the S/PDIF input of the card. 

• ADSP24 Multiple PCM In (n) – this is an interleaved driver to record several 
channels at the same time. Some older audio applications will use this driver 
to access multiple channels on soundcards.  

• ADSP24 Digital Mixer (n) – with this driver you can record the output signal 
of the Output Mixer . This can be used to record output signals from one 
application in another program for example. 

Additionally, the card provides an ASIO 2.0 driver called ADSP24 ASIO. It allows 
access to all 10 input and 10 output channels (8 ADAT + 2 S/PDIF) in applications 
that support ASIO (like Cubase VST). ASIO allows applications to record and 
playback at a very low latency (down to 2ms). This means that it is possible to 
apply realtime effects with your systems CPU input or output signals. Also, you 
can use software synthesizers to output through ASIO. 

Please note that most applications will need special settings to ensure that the 
MEDIA 7.1 is working properly. We are continuously testing the card with various 
popular applications. In the following sections we have provided examples of a few 
applications. Please take the time to review it to avoid problems later. 

Setting up Emagic Logic SoundTrack24 

Logic SoundTrack24 is a special version of the Logic Software from Emagic, 
designed to be used with the DSP24 series of audiocards. It can use the ASIO driver 
of the MEDIA 7.1 for recording and playback. Logic SoundTrack24 works under 
Windows 9x/Me. 

• call File>Hardware settings in Media7.1 Output Mixer. 
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• under Device Setting  select the ASIO buffer size: we recommend using a 

value of about 1024 – depending on the system performance. 
• click on the ASIO button under DeviceMixing. 
• make sure the option Rate Locked under Clock Setting is disabled 
• set the option MultiTrack Wave Drivers to Independent (under Clock Setting) 
• launch Logic SoundTrack24 and select the option Audio>Audio Hardware & 

Drivers. 

  
• select Audio & Hardware Drivers and select ASIO ADSP 24 as ASIO device. 

If you want to work with 24-bit resolution, enable the option 20/24 Bit 
Recording. 

• exit Logic and launch it again to activate the settings.  
Please also refer to the documentation of Logic SoundTrack24. 



ST AUDIO MEDIA 7.1 

- 28 - 

Setting up Steinberg Cubase VST/24 3.72 

Cubase VST 3.72 from Steinberg uses the ASIO specification to access recording 
hardware. Steinberg has defined ASIO and improved support for recording 
multiple channels at the same time. ASIO features reduced latency for playback of 
VST plugins and instruments. Please note, that other Steinberg programs (like 
Nuendo, Cubasis VST or Cubase VST 5.0) have a very similar setup when using 
the ASIO driver. To setup the MEDIA 7.1 in Cubase VST, please follow these 
steps: 

• call File>Hardware settings in Media7.1 Output Mixer. 

 
• Select the ASIO buffer size. On faster systems (Pentium III, Athlon) it is 

usually safe to use 512  as a small setting. On other systems you may try this 
setting but increase the buffer size later, depending on the performance. Also 
you can decrease the buffer size but please test if the performance is OK on 
your specific system. 

• click on the ASIO button under DeviceMixing. 
• Start Cubase VST and select the option Audio>System . 
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• In the section Audio Performance , set Number of Channels to 16 

(recommended). 
• In the Monitoring section, select Global Disable (recommended). If you want 

to monitor signals in realtime and adding VST plugin effects at the same time, 
select Tape Type instead.  

• In the upper right corner under ASIO Device select ADSP24 ASIO. By 
clicking on ASIO Control Panel , you can also change the samples per buffer 
value. 

• Below that you can choose the Sample Rate. 
• If you want to use the DSP24’s realtime monitoring functions (without 

adding effects to the monitor signal), select ASIO Direct Monitoring 
To define which input and outputs to use in Cubase VST, first go to Audio>Inputs. 
A window will appear that allows you to activate or deactivate each input (stereo). 
You can assign these inputs to the channels in the VST Channel Mixer then (via 
Audio>Monitors). For the outputs, you need to open Audio>Master. In this 
window you can deactivate a stereo bus for each stereo output. These busses can be 
used internally in Cubase VST to route signals to the outputs. You can find more 
information about this in the Cubase VST documentation. Also, the latest updates 
for Cubase VST can be downloaded from http://www.steinberg.de. 
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Setting up Emagic Logic Audio Platinum 4.7 

The powerful Audio-/MIDI-Sequencer Logic Audio Platinum 4.7 (and higher) 
from Emagic also uses ASIO drivers. Fo llow these steps to setup the application for 
the MEDIA 7.1. 

• call File>Hardware settings in Media7.1 Output Mixer. 

 
• select the ASIO buffer size: we recommend using a value of about 1024 – 

depending on the system performance. 
• click on the ASIO button under DeviceMixing. 
• launch Logic Audio Platinum and select the option Audio>Audio Hardware 

& Drivers>Audio Driver 2. 
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• check the box ASIO and select ASIO ADSP24 as ASIO device. If you want to 

record with 24-bit resolution, check the box 20/24 Bit Recording 
• exit Logic Audio and launch it again to activate the changes.  
You can get the latest informations about Logic Audio Platinum at 
http://www.emagic.de. If you use previous 4.xx versions of Logic Audio, we 
recommend to get the free update to Version 4.7 at least. 

Setting up Cakewalk Pro Audio 9.x 

Cakewalk Pro Audio is a famous Audio-/MIDI-Sequencer and recordingsoftware. 
It uses the MME drivers of the MEDIA 7.1. Other recent versions of Cakewalk 
need a very similar setup. 

• launch Cakewalk and select Options>Audio. The DirectShow Audio  dialog 
will be displayed. 
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• Click on Drivers. You will see a list of MME devices for Input and Output. 

Select the entries you want to use (check the section AVAILABLE IN- AND 
OUTPUT DEVICES earlier in this chapter for reference). Usually you should 
select at least ADSP24 Ext. (1) Input 1/2  and ADSP24 Ext. (1) WaveOut 1/2. 

• Go back to General and select Wave Profiler. Follow the directions on screen 
until you see the message Audio hardware has been successfully profiled. 

• Select ADSP24 Ext.(1) WaveOut 1,2 as Playback Timing Master and 
ADSP24 Ext. (1) Input  1,2 as Record Timing Master. If you are recording 
from the S/PDIF input, select ADSP24 S/PDIF In (1) instead. The option 
Audio Driver Bit Depth  should be set to 24. 

• Select the sample rate and resolution you want to use under Default Settings 
for New Projects. 

• Mixing Latency: Basically, you can set Buffers in Playback Queue as 4. 
Settings less than 4 will result in lower latency but the system performance 
could be lower, resulting in possible drop-outs. Start with buffer sizes 
suggested by the Effective latency tests, usually around 100msec. When the 
latency needs to be under 100msec, click on the Advanced tab and enable the 
WavePipe(TM) Acceleration  option. Please note that each system will have 
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different optimal settings. You should experiement with the settings to get the 
perfect setup for your system. 

• Under Device Profiles, enable the option Use Wave Out Position For Timing. 
You can get the latest updates and informations on Cakewalk on 
http://www.cakewalk.com. 

Setting up Nemesys GigaSampler 1.64 

GigaSampler from Nemesys is a powerful and very popular software sampler. The 
MEDIA 7.1 provides a special GSIF-driver (GigaSampler-InterFace) that allows 
you to use the separate outputs of the card with GigaSampler. We do not 
recommend to use older versions than GigaSampler 1.64. Also, the performance 
using the newer GigaStudio 2.2 (and above) by Nemesys is much better. 

• call File>Hardware settings in Media7.1 Output Mixer. 

 
• press on the GSIF button under DeviceMixing – or select GSIF for at least 

one channel. 
• launch GigaSampler and select Config>Outputs. 
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• Under Wave Out Driver, select Audio DSP24 MultiChannel Driver. 
• Select the Output channels you want to use on the right side under Outputs 

Enabled. 
• Now assign the Midi Channels mapped to Outputs in the lower area. 

You can get the latest informations and updates of GigaSampler on their website 
http://www.nemesysmusic.com. 
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X. Troubleshooting / FAQ 

This chapter addresses common questions to solve possible problems and avoid 
conflict with other PC hardware or specific system configurations.  

Q: Can I use the card with an AMD Athlon / Duron / Thunderbird CPU? Will it work 
with a VIA Cyrix CPU? 

A: Yes, of course! There are no compatibility issues with microprocessors. Please also check 
the following question about VIA chipsets, as many mainboards for AMD and VIA CPUs are 
based on VIA chipsets. 

Q: What about VIA chipsets? Can I use my VIA chipset based mainboard with the card?  

A: Yes, you can use VIA based systems with the DSP24 series of cards. Unlike with some other 
chipsets, the configuration in this case is more 'sensitive' and the s ystem needs to be properly 
configured to avoid possible trouble: 
Please make sure the DSP24 PCI card gets a unique and unshared IRQ. Secondly, a recent 
version of the VIA 4 -in-1 driver (we recommend at least v4.31) and the VIA USB Filter driver 
must be installed (check http://www.via.com.tw/ or the website of your mainboard 
manufacturer). If you are using Windows 98SE with USB enabled, Microsoft's UHCD Update 
should be used as well (do a search for 'uhcd.sys' on Microsoft's Knowledge Base). 

Please check if there is an update for the BIOS of your mainboard ... if so, please download and 
use it. 

On mainboards with the KT133 and KT133A chipset, you must use high quality 133MHz 
memory modules only. Also check the correspsonding setting in your BIOS (it should be set to 
133MHz) and make sure the memory timing is not set to an incorrect (e.g. too low) value. 

Set PCI DELAY TRANSACTION in your BIOS to DISABLED. Then, set PCI DEVICE 
LATENCY TIMER to a value of 32 or lower. PCI MASTER READ CACHING should be set 
to DISA BLED as well (could cause performance problems, but because of the VIA 
southbridge bug, this setting is required). 

Last but not least, we recommend to disable all power managment related functions.  

Q: Is it possible to install this card in a system with onboard-sound or another 
soundcard?  

A: Usually yes. As long as the other soundchip does not use a Envy24 / ICE1712, there should 
be no problems. You should make sure that both devices do not share their IRQ. 

Q: How many available IRQs do I need to use the card? 

A: Exactly one. It should be unshared if possible, because the DSP24 is a busmaster device ... 
otherwise you might get performance problems. It does not matter which IRQ number has been 
assigned to the card. 

Q: I have read that the card is full duplex, but I can't do simultaneous record and 
playback with Cakewalk!  
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A: Simultaneous record and playback needs to be enabled in Cakewalk Pro Audio. In the 
software, go to Settings > Audio Options > Advanced and make sure Enable simultaneous 
record and playback is checked. 

Q: I am using Cubase VST 5.0 and I'm getting crazy: always when I change a setting 
inside Media7.1 Output Mixer or the mixer, the playback suddenly stops!  

A: Make sure the menu entry Options > Active in Background is checked inside Cubase. This is 
a general Cubase setting and not related to the audiocards driver. 

Q: I am using Cubase VST 3.xx and I'm getting crazy: always when I change a setting 
inside Media7.1 Output Mixer or the mixer, the playback suddenly stops!  

A: Goto File > Preferences and make sure that Active in Background  is checked for MIDI and 
Audio. This is a general Cubase setting and not related to the audiocards driver. 

Q: When recording or playing audio, I get an audible click about every 3 to 5 seconds. Is 
the hardware defective? 

A: No! First of all, check the following two settings: 

Make sure the 'auto-play' function for CD-ROMs is disabled. Goto Control Panel > System > 
Device Manager > CD -ROM and select Properties for all CD-ROM drives. Now disable Auto 
Insert Notification under Settings. 

DMA access for your IDE HDDs must be enabled. Goto Control Panel > System > Device 
Manager > Disk Drives and select Properties for each IDE-HDD you have installed (an entry 
is typically called GENERIC IDE DISK TYPExx). Now enable DMA under Settings. 

Please check these settings from time to time. Some Windows installations 'loose' the DMA 
and CD-ROM notification settings when you are changing certain elements in the hardware 
configuration or if you boot Windows in Safe Mode. 

Q: I can hear cracks and noise when I play my recorded audio signal! Is this a hardware 
problem? 

A: In most cases this problem can be solved by changing the interrupt which has been assigned 
to your hardware. Check in Control Panel > System > Device Manager > Computer > 
Properties  if there is another hardware component using the same interrupt as the DSP24 
PCI-card (it should have its own interrupt, especially on mainboards using the VIA chipset). 
Except an IRQ-Holder entry, no other device should be listed with the same IRQ number. If 
you find such a problem, you usually have to install the DSP24 PCI card into a different PCI 
slot. On some mainboards you can change the IRQ assignment inside the BIOS of your 
mainboard. 

Q: I can hear noise when I move a window or fader on screen inside my audio application. 
I am using an ATI Rage 128 graphic card. 

A: Please download and install current drivers for your graphic card and set the bit-depth to 
32bit (not lower). This will reduce the system load the graphic card is causing. 

Q: I can hear noise when I move a window or fader on screen inside my audio application. 
I am using an Matrox Millenium/Mystique/G200 card. 
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A: Please download and install current drivers for your grpahic card. Inside the Matrox specific 
options you can find a setting called Busmastering - please disable it. 

Q: Can I use Logic SoundTrack24 under Windows 2000/XP?  

A: No, this is not possible. All Logic 4.x versions from Emagic do only work under Windows 
9x/Me ... Windows 98 SE is recommended.  

Q: I am not able to chang e the MME / ASIO / GSIF settings for the multiclient driver in 
the Hardware Settings dialog. 

A: Under Windows NT 4.0 and Windows 2000, these settings are not available as there is no 
multiclient support for GigaSampler-/Studio on this operating system. GigaSampler/-Studio 
currently do not work under Windows NT 4.0 or Windows 2000 (that is not related to our 
driver, that is a general limitation). 

Q: Why do I get error messages that the ASIO Multimedia test/configuration failed using 
Cubase VST, Cubasis VST or Nuendo from Steinberg? 

A: This test is done by the ASIO Multimedia driver from Steinberg that simulates ASIO for 
soundcards without ASIO support. It would disappear as soon as this driver is configured 
properly. However, as the DSP24 series of cards have their own ASIO driver for Windows 
9x/Me/2000, you don't need to run this test at all. Just select the ASIO driver (ASIO ADSP24) 
and then the ASIO Multimedia driver will no longer be used. 
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XI. Support / Contact 

ST Audio offers various resources to provide customer support. Please visit our 
website www.STAUDIO.com to access our customer service area. 

The Q&A forum on the website provides help – please use it to discuss all issues 
related to our products. Our qualified support staff from all over the planet (and 
some from other planets) will help you to solve issues you may have. Do not 
hesitate to use the Q&A forum for any question you might have. Other customers 
read the messages and will possibly reply to the requests on this forum as well. 

You can find updated versions of drivers, applications and documentation on our 
webserver. 

The extensive Knowledge Base and FAQ sections of our website, deal with 
common issues and are updated frequently by us. Please check this resource from 
time to time to get the latest updates on your DSP24 card.  

 

 

 

 

 

 

 

 

 


